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ÂÁ\õ¯®1.
1.1 ]Ô¯ Ãmkz ÷uõmhzvØPõÚ |õØÖUPøÍ EØ£zv ö\´÷Áõ®

C¢u E£ Azv¯õ¯zøuU PØ£uß ‰»®

 y ©soß ÁÍzøu¨ ÷£nÄ®

 y {»zvÀ PÈÄ¨ ö£õ¸ÒPÒ ÷\ºÁøuU SøÓ¨£uØS® 

 y £°ºaö\´øPUSz ÷uøÁ¯õÚ |køP¨ ö£õ¸mPøÍz u¯õº 

ö\´¯Ä®

 y |õØÖ÷©øh¨ £µõ©›¨¤ß ‰»® Ãmkz ÷uõmhzvØSz 

÷uøÁ¯õÚ |õØÖUPøÍ¨  ö£ÓÄ®

C¯¾©õS®.

G©x _ØÖ¨¦Óa `Çø»U PÁºa]Pµ©õP¨ ÷£qÁuß ‰»® 

©QÌøÁ¨ ö£Ó•i²®. G©x Ãmiß A¯Ø`ÇÀ, £õh\õø» 

ÁÍÄ BQ¯Ú A»[Põµ©õP C¸US®ö£õÊx ¦xzöu®¦hß 

PÀÂ |hÁiUøPPøÍ ÷©ØöPõÒÍ •i²®. ÷©¾®, |a_¨ £uõºz 

u[PÍØÓ EnÄ ÁøPPøÍ¨ ö£Ó•iuÀ, ÷©»vP Á¸©õÚ® 

QøhzuÀ ÷£õßÓ £¯ßPÒ £»ÁØøÓ²® ö£ØÖUöPõÒÍU 

Ti¯uõPÄ® C¸US®.

ÃmkÁÍøÁ A»[Põµ©õP¨ ÷£q®÷£õx £» Âh¯[PÒ P¸zvØ 

öPõÒÍ¨£h ÷Ásk®. Cuß÷£õx, ¤µuõÚ©õP Cµsk Âh¯[PÒ 

£ØÔU PÁÚ® ö\¾zx÷Áõ®.

 y Ãmkz÷uõmh ©søn ÁÍ©õP¨ ÷£quÀ.

 y Ãmkz÷uõmhzvÀ £°ºö\´ÁuØSz ÷uøÁ¯õÚ |õØÖUPøÍ 

EØ£zvö\´uÀ.
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Ãmkz÷uõmh ©søn ÁÍ©õP¨ ÷£q÷Áõ®

©s, £°ºaö\´øPUS CßÔ¯ø©¯õu Ai¨£øhU Põµo¯õS®. 

uõÁµ[PøÍz uõ[SÁx® ÷£õ\ønø¯ ÁÇ[SÁx® ©soß  

öuõÈÀPÍõS®. ©s, ÁÍ® SßÖÁuØS ¤ßÁ¸® Põµn[PÒ 

HxÁõP Aø©QßÓÚ. 

 y öuõhºa]¯õP¨ £°ºö\´ÁuÚõÀ ©so¼¸¢x ÷£õ\øn 

‰»P[PÒ  CÇUP¨£hÀ

 y ©sn›¨¦  {PÊuÀ

 y ©sqhß ö£õ¼zwß, ¤ÍõzvUS ©ØÖ®  £À÷ÁÖ  Cµ\õ¯Ú¨ 

£uõºzu[PÒ, C»zvµÛ¯À  \õuÚ¨ £õP[PÒ BQ¯Ú ÷\ºuÀ 

©sn›¨ø£z uk¨£uØS® uøµ°À PÈÄ¨ ö£õ¸ÒPÒ ÷\ºÁøuU 

SøÓ¨£uØS©õÚ ÁÈ•øÓPÒ öuõhº£õP AÔ¢x öPõÒ÷Áõ®.

©sn›¨ø£z ukzuÀ

AvPÍÄ ©sn›¨¤ØS 

Em£mh uøµ

©øÇ}›ÚõÀ ©soß ÁÍ©õÚ ÷©Ø£øh 

PÊÂ APØÓ¨£h÷» ©sn›¨¦ GÚ¨£k®. 

\õ´ÁõÚ uøµPÎÀ AvPÍÄ ©sn›¨¦ 

|øhö£Ö®. ©øÇzxÎPÒ ©soÀ ÂÊ® 

÷£õx ©s xoUøPPÒ ÷ÁÓõUP¨£mk £õ´¢x 

ö\À¾® }¸hß Gkzxa ö\À»¨£k®.

CuØPø©¯, ©sn›¨ø£z uk¨£uØPõÚ |hÁ 

iUøPPÎß÷£õx ¤ßÁ¸® C¸ Âh¯[PÒ 

öuõhº£õPU PÁÚ® ö\¾zu ÷Ásk®.

 y ©øÇzxÎPÒ  ©s ÷©Ø£µ¨¤À   ÂÊ®÷£õx  ©s xoUøPPÒ 

÷ÁÓõUP¨£kÁøuz ukzuÀ 

 y ©øÇ}º Kk® ÷ÁPzøuU SøÓzuÀ

CuØöPÚ G®©õÀ ÷©ØöPõÒÍ¨£h ÷Ási¯øÁ GøÁö¯Ú 

AÔ¢xöPõÒ÷Áõ®.
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E°›z uøhPøÍ HØ£kzuÀ

©øÇzxÎPÒ uøµ°À ÂÊ®÷£õx ©s xoUøPPÒ ÷ÁÓõÁøuz 

uk¨£uØS® ©øÇ}›ß Kk® ÷ÁPzøuU SøÓ¨£uØS® GÚ  ©øÇ 

}º Kk® vø\USU SÖUPõP £À÷ÁÖ uõÁµ[PÒ |h¨£k®. CuØ 

PõÚ Euõµn[PÒ ]» R÷Ç uµ¨£mkÒÍÚ.

QÎ›^i¯õ ÷Á¼ 

Aø©zuÀ

§\Û, öÁÒÍ› ÷£õßÓ 

öPõi ÁøPPøÍ |hÀ

÷\µ, öÁmi÷Áº ÷£õßÓ 

uõÁµ ÷Á¼PøÍ Aø©zuÀ

 y }º £õ´¢x ö\À¾® vø\USU SÖUPõP ö£õßÚõ[Pso, 

ÁÀ»õøµ BQ¯ £¯›ºPøÍ |h»õ®.

E°µØÓ uøhPøÍ HØ£kzuÀ

A¯Ø`Ç¼À QøhUPzuUP E°µØÓ £uõºzu[PøÍz uøhPÍõP 

CkÁuß ‰»® ©sn›¨ø£z ukUP •i²®. C[S, }º £õ²® vø\

USU SÖUPõP PØPÒ, ©µUSØÔPÒ, öußÚ® ©møhPÒ BQ¯ÁØøÓ 

Cmkz uøhPøÍ HØ£kzxÁuß ‰»® ©mk©ßÔ ©s vmkPøÍ 

Aø©¨£uß ‰»•® }º £õ´¢x ö\ÀÁx ukUP¨£k®. 

©øÇzxÎPÒ ÂÊÁuÚõÀ ©s xoUøPPÒ ÷ÁÓõÁøuU 

SøÓ¨£uØS P°ØÖ¨£õ´, \õUS, ö£õ¼zwßuõÒ BQ¯ÁØøÓ 

©soß «x Â›UP»õ®. ÷©¾®, ©soß «x øÁU÷PõÀ, QkS 

BQ¯ÁØøÓ CkÁuß ‰»•® ©sn›¨ø£U SøÓUP»õ®.

PÀ÷Á¼ Aø©zuÀ©s {µ¨£¨£mh EøÓPøÍ 

AkUSuÀ  

£øÇ¯ CÓ¨£º 

xøh¨£[PøÍ CkuÀ
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E°¸ÒÍ ©ØÖ® E°µØÓ uøhPøÍa ÷\ºzx¨ £¯ß£kzuÀ

©soß«x £øÇ¯ P°ØÖ¨ £õ´, \õUS BQ¯ÁØøÓ Â›zx AÁØ 

Ôß«x ]Ô¯ xøÍPøÍ Cmk |õØÖUPøÍ |õmh»õ®.

©s {µ¨£¨£mh              

EøÓPøÍ Cmk AvÀ  

|õØÖUPøÍ |kuÀ

øÁU÷Põ¼ÚõÀ uøµø¯ 

‰kuÀ

©s umkUPÎß «x ö£õ¼z 

wß Â›UP¨£mk  xøÍ Ch¨ 

£mk uõÁµ[PøÍ |kuÀ

ö\¯Ø£õk 1.1
E[PÍx £õh\õø»z ÷uõmhzvÀ ©sn›¨¦ HØ£mh 

Chö©õßøÓz öu›Äö\´xöPõÒP. E[PÍõÀ ö£ØÖU 

öPõÒÍUTi¯ E°¸ÒÍ, E°µØÓ £uõºzu[PøÍ¨ £¯ß£kzv 

©sn›¨ø£z ukUP |hÁiUøPö¯kUPÄ®.

PÈÄ¨ö£õ¸mPøÍa \›¯õÚ •øÓ°À •Põø©zxÁ® ö\´÷Áõ®

£¯ÚØÓöuÚU P¸v APØÓ¨£k® PÈÄPøÍ ^µõP •Põø© ö\´ 

Áuß ‰»® AÁØøÓ ÁÍ[PÍõP «sk® £¯ß£kzuU Ti¯uõP 

C¸US®.  

÷ÁÓõUP¨£hõ

v¸¨¤ß

÷ÁÓõUP¨£mi

¸¨¤ß

PÈÄ¨ ö£õ¸ÒPÒ

 
PÈÄ 

 ÁÍ®
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PÈÄ¨ ö£õ¸ÒPøÍ ¤µuõÚ©õP CµshõP ÁøP¨£kzu»õ®.

1. ]øuÁøh¯UTi¯øÁ

2. ]øuÁøh¯õuøÁ

 y ]øuÁøh¯UTi¯øÁ

\ø©¯»øÓU PÈÄPÒ (Põ´PÛPÎß ÷uõÀ, ÷u[Põ´¨§, 

EnÄU PÈÄPÒ) ©µ[PÎ¼¸¢x ÂÊ® Cø», \¸S BQ¯Ú 

Cv»h[S®.

 y ]øuÁøh¯õuøÁ

ö£õ¼zwß, ÷u[Põ´a  ]µmøh, Psnõi, £øÇ¯ uPµ¨ 

÷£oPÒ, ¤ÍõzvUSU Si}º ©ØÖ® SÎº£õÚ¨ ÷£õzuÀPÒ, 

¥[Põß BQ¯Ú Cv»h[S®.

C¢u Cµsk ÁøP¯õÚ PÈÄPÎ¾® `Ç¾US AvP £õv¨ø£ 

HØ£kzxÁÚ ]øuÁøh¯õu PÈÄ¨ ö£õ¸ÒPÍõS®.

PÈÄ¨ö£õ¸Ò •Põø©zxÁzvß •uÀ \¢uº¨£® PÈÄPøÍ 

öÁÆ÷ÁÓõPa  ÷\P›zu»õS®. Cx PÈÄ E¸ÁõS® \¢uº¨£zv÷»÷¯ 

÷©ØöPõÒÍ¨£h ÷Ásk®.

]øuÁøh¯zuUP PÈÄ¨ö£õ¸mPøÍ •Põø© ö\´uÀ

ÃmiÀ AÀ»x £õh\õø»°À ÷\¸® GÀ»õ ÁøP¯õÚ ]øuÁ 

øh¯zuUP PÈÄPøÍ²® Tmöh¸z u¯õ›¨£uØS›¯ ‰»¨ 

ö£õ¸mPÍõP¨ £¯ß£kzu •i²®. £À÷ÁÖ •øÓPÎÀ Tm 

öh¸z u¯õ›¨ø£ ÷©ØöPõÒÍUTi¯uõP C¸¨¤Ý® Aøh¨¦ 

•øÓ GÚ¨£k® Tøh •øÓ÷¯ ªP C»SÁõÚuõS®.
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ö\¯Ø£õk 1.2 
Tmöh¸ Aøh¨ö£õßøÓz  u¯õ›¨÷£õ®

÷uøÁ¯õÚ ö£õ¸mPÒ

y 1  1/2 m }Í•® 2.3 cm Âmh•® öPõsh ©µUP®¦PÒ AÀ»x   P•Pg 

\»õøP  AÀ»x QÎ›^i¯õ P®¦PÒ 35

 y ÁøÍ¯UTi¯ ‰[QØ R»[PÒ

 y P°Ö  

÷uøÁ¯õÚ E£Pµn[PÒ 

©söÁmi, A»Áõ[S, Pzv

u¯õ›US® •øÓ  

 y Tmöh¸ Aøh¨ø£ Aø©¨£uØSz öu›Ä 

ö\´u Chzøua _zu® ö\´x öPõÒÍ 

Ä®.   

 y E¸ 1 CÀ  EÒÍÁõÖ 60 cm Âmh•ÒÍ Ámh 

ö©õßøÓ {»zvÀ SÔzxU öPõÒP. 
 y CÆÁmhzvß £›v°À 4 & 5 cm  AÍÄ Cøh 

öÁÎ°À 20 cm AÍÄ BÇzvØSz xøÍPøÍ 

Aø©UP. (E¸&2) CuØPõP A»Áõ[Qß TµõÚ 

•øÚø¯¨ £¯ß£kzu»õ®. E¸  & 1

E¸ 2
E¸ 3

 y AzxøÍPÎÝÒ P®¦PøÍ |õmi AøÁ Aø\¯õuÁõÖ CÖUP¨£hÀ 

÷Ásk®. QÎ›^i¯õ uiPøÍ |kÁuõ°ß AÁØÔß Ai¨£Sv 

RÌ¨£Sv°À C¸US©õÖ |mk, AÁØÔÀ ÷Áº E¸ÁõS® Áøµ J¸ 

Áõµ©ÍÂØS }¹ØÖuÀ ÷Ásk®.
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 y E¸  3 CÀ Põmh¨£mkÒÍÁõÖ |h¨£mh P®¦PøÍa _ØÔ ‰[QØ 

R»[PøÍ øÁzx, P°ØÔÚõÀ Pmi EÖv¯õÚuõP Aø©zxUöPõÒÍ 

÷Ásk®.

CÆÁõÖ u¯õºö\´¯¨£mh Tøh°ÝÒ ]øuÁøh¯zuUP PÈÄ 

PøÍ CmkU öPõÒÍ»õ®.  Tmöh¸U Tøh°ß  Ai°ÞhõPU 

Tmöh¸øÁa ÷\P›UP»õ®. C¢u Tmöh¸, Ãmkz ÷uõmhzv¾ÒÍ 

£°ºPÐUS¨ £¯ß£kzxÁuØS¨ ö£õ¸zu©õÚuõP C¸US®.

Tmöh¸U Tøhø¯z u¯õ›¨£uØöPÚ QÎ›^i¯õU  P®¦PøÍ¨  

£¯ß£kzvÚõÀ AÁØÔÀ QøÍPÒ E¸ÁõS®. AUQøÍPøÍ 

öÁmi Tmöh¸U Tøh°À  CkÁuß  ‰»©õP  Tmöh¸  ÁÍ® 

ö£Ö®.  ÷©¾®,  CUTøhø¯ }sh Põ»©õP¨ £¯ß£kzuU Ti¯ 

uõPÄ® C¸US®.

£°ºPÐUS Tmöh¸ CkÁuß AÝT»[PÒ

●  uõÁµ[PÐUSz ÷uøÁ¯õÚ ÷£õ\ønPÒ QøhUS®

●  ©s yºøÁ¯õUP¨£mk ÁÍ©øh²®

●  ©s Dµ¼¨¦¨ ÷£n¨£k®

]øuÁøh¯õu PÈÄ¨ö£õ¸mPøÍ •Põø© ö\´uÀ

CøÁ `Ç¾US¨ £õv¨ø£ HØ£kzx®. GÛÝ®, £À÷ÁÖ ]øu 

Áøh¯õu PÈÄ¨ ö£õ¸mPÎ¼¸¢x u¯õ›UP¨£mh ö£õ¸mPÒ 

£õÁøÚUS EP¢uÚÁõS®. ÷©¾®, ]øuÁøh¯õu  ÷©¾øÓ 

PÎøÚ¨ £¯ß£kzv ö£õvö\´¯¨£mh EnÄ¨ ö£õ¸ÒPøÍ 

Esq® £ÇUPzøu |õ® öPõskÒ÷Íõ®. BP÷Á, AßÓõh 

ÁõÌÂÀ ]øuÁøh¯õu PÈÄ¨ö£õ¸mPÒ E¸ÁõÁøuU Pmk¨ 

£kzu ÷Ásk®. CuØPõP ÷©ØöPõÒÍU Ti¯ |hÁiUøPPÒ ]» 

Á¸©õÖ. 

1'   £¯ß£õmøhU SøÓzuÀ (Reduce)
£õÂ¨£øuU SøÓ¨£uß ‰»÷©õ, £¯ß£õmøh {ÖzxÁuß 

‰»÷©õ, PÈÄPÒ ÷\ºÁx SøÓÁøh²®. Cx PÈÄ¨ ö£õ¸Ò 

•Põø©zxÁzvß •UQ¯ £i•øÓ¯õS®.
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 y \¢øuUSa ö\À¾®÷£õx xo°»õÚ  ø£ø¯÷¯õ £øÚ÷¯õø»¨ 

ø£ø¯÷¯õ öPõsk ö\ÀÁuß ‰»® ÃmiÀ ö£õ¼zwß ø£  

÷\ºÁx SøÓ²®.

 y   EnÄPøÍ¨ ö£õvö\´ÁuØS ÁõøÇ°ø» AÀ»x EnÄ¨ ö£m 

iPøÍ¨ £¯ß£kzxÁuß Põµn©õP vÚ¢÷uõÖ® ö£õ¼zwß 

`Ç¼À ÷\ºUP¨£kÁøuU SøÓUP»õ®.  

2' «Í¨ £¯ß£kzuÀ (Reuse) 

£¯ß£õmiß Põµn©õPa ÷\¸® PÈÄ¨ö£õ¸mPøÍ «ÍÄ® 

£¯ß£kzxÁx  öuõhº£õP |õ® PÁÚ® ö\¾zu ÷Ásk®.

² Ãmkz÷uõmhzxUSz ÷uøÁ¯õÚ |õØÖUPøÍ |kÁuØPõP 

xøÍ°h¨£mh   ]µmøh, öÁØÖ ÷¯õUPm ÷Põ¨ø£, öÁØÖ 

£õÚU ÷Põ¨ø£, ö£õ¼zwß EøÓ, ¤ÍõzvUS¨ £õzvµ[PÒ 

BQ¯ÁØøÓ¨ £¯ß£kzu •i²®. 

² £°º ÂzxUPøÍ |kÁuØS öÁØÖ¨ £õÀ ø£UPØ, ö£õ¼zwß 

EøÓPÒ, £À÷ÁÖ ¤ÍõzvUS¨ £õzvµ[PÒ, £øÇ¯ µ¯ºPÒ 

÷£õßÓÁØøÓ¨ £¯ß£kzu»õ®.

   öÁØÖ¨ ¤ÍõzvUS 

öPõÒP»ß

    ]µmøhöÁØÖz u°ºa \mi £øÇ¯ µ¯º

3' «Ò_ÇØ] (Recycle)
PÈÄ¨ö£õ¸Ò •Põø©zxÁzvß÷£õx £¯ß£kzu •i¯õu 

PÈÄ¨ö£õ¸ÒPÍ «Ò_ÇØ]US Em£kzu»õ®.  SÔ¨¤mh PÈÄ¨ 

ö£õ¸öÍõßøÓ £¯ß£õk öPõsh ©ØöÓõ¸ ‰»¨ö£õ¸ÍõP 

©õØÖu÷» PÈÄ¨ö£õ¸Ò «Ò_ÇØ] GÚ¨£k®. ]øuÁøh¯õu 

PÈÄ¨ö£õ¸ÒPøÍ £õh\õø»°÷»õ Ãmi÷»õ «Ò_ÇØ] ö\´¯ 

•i¯õx. BÚõÀ, «Ò_ÇØ]UöPÚ AÁØøÓ EÒÑµõm] {ÖÁ 

Úzvh® AÀ»x uÛ¨£mh ÷\P›¨£õÍ›h® øP¯ÎUP ÷Ásk®.
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Reduce, Reuse, Recycle GÚ ÷©÷» ÂÍUP¨£mh £i•øÓPÒ ‰ßÖ® 

PÈÄ¨ ö£õ¸Ò •Põø©zxÁzvß J¸[÷P 3 R GsnUP¸ GÚ 

AøÇUP¨£k®. 

CÆ GsnUP¸ÄUPø©¯ PÈÄPÍõP ©õÖ® 

ö£õ¸mPÎß £õÁøÚ SøÓÁøh²®÷£õx 

«sk® £¯ß£kzu ÷Ási¯ AÍÄ® 

SøÓÁøh²®. CuØPø©¯ «Ò_ÇØ] 

ö\´ÁuØPõÚ  AÍÄ® SøÓÁøh²®.

«Ò_ÇØ] ö\́ ²® {ø»̄ [P ÎÀ                           

]øuÁøh¯õu PÈÄ¨ö£õ¸ÒPÒ «Í¨ 

£¯ß£kzuUTi¯ {ø»US ©õØÓ¨£k®. 

Cuß÷£õx «Ò_ÇØ] ö\´¯•i¯õx Gg_®  

PÈÄ¨ö£õ¸ÒPÒ £›P›¨¦US (Treatment) Em£kzu¨£k®.

Cuß÷£õx CÆÁõÓõÚ £uõºzu[PÎ¾ÒÍ |a_zußø© APØÓ¨ 

£mk SøÓÁõÚ Ch¨£µ¨ø£U öPõÒÍzuUP Âu©õP ]Ô¯uõP 

©õØÓ¨£k®. C¨£i•øÓ°ß ¤ßÚº E¸ÁõS® £SvPÒ (Trash)
`Ç¾US¨ £õv¨ø£ HØ£kzuõu ÁøP°À APØÓ¨£k®.

Treatment,  Trash BQ¯ ö\¯ß•øÓPÒ Cµsk® PÈÄ¨ ö£õ¸Ò 

•Põø©zxÁzvÀ 2T GsnUP¸ GÚ¨£k®.

Ãmkz÷uõmhzvÀ |kÁuØS  |køP¨ö£õ¸ÒPøÍz u¯õº 

ö\´÷Áõ®

£°ºaö\´øP°ß÷£õx |kÁuØS¨ £¯ß£kzu¨£k® ÂzxUPÒ, 

uskz xsh[PÒ, |õØÖUPÒ BQ¯Ú |køP¨ö£õ¸mPÒ GÚ¨ 

£k®. |kÁuØ÷PØÓÁõÖ |køP¨ ö£õ¸mPøÍz u¯õºö\´²® 

Âu® £ØÔ AÔ¢x  öPõÒ÷Áõ®.

JÆöÁõ¸ £°ºaö\´øP°ß÷£õx® |køPUS¨ £¯ß£kzu¨£k®. 

|køP¨ ö£õ¸mPøÍ¨ ÷£õßÖ A¢|køP¨ ö£õ¸mPøÍz u¯õº 

ö\´²® •øÓPÐ® JßÖUöPõßÖ ÷ÁÖ£mhÚÁõS®. 

3 R GsnUP¸
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ö\¯Ø£õk 1.3
|kÁuØ÷PØÓÁõÖ ÂzxUPøÍz u¯õº ö\´÷Áõ®

÷uøÁ¯õÚ ö£õ¸mPÐ® E£Pµn[PÐ®

 y |ßS •ØÔ¨ £Êzu ¤ßÚº E»µ Âh¨£mh ö\zuÀ ªÍPõ´PÒ

 y |ßS £Êzu Pzu›UPõ´PÒ ]»

 y |ßS £Êzu  uUPõÎ¨ £Ç[PÒ ]»

 y E»º¢u  öÁsi ö|ØÖUPÒ ]»

 y E»º¢u  £¯ØøÓ ö|ØÖPÒ ]»

 y _zu©õÚ E»º¢u ÷£õzuÀPÒ ]» (ÂzxU  

PøÍU PÍg]¯¨£kzu)

 y _zu©õÚ Phuõ]z uõÒPÒ

 y uizu xozxsk, }º

 y Pzvö¯õßÖ, Pµsi, ]» £õzvµ[PÒ ÂzxPøÍa 

÷\P›¨£uØS

 y Pµsi

 y \À»øh

 y CÓ¨£ºU øP²øÓ

•ß B¯zu®

 y |õmkÁuØöPÚ   ÂzxUPøÍ¨  ö£ÖÁuØS›¯ |õØÖUPøÍ¨  

ö£ÖÁuØS  ]Ó¢u C¯À¦PÒ öPõsh uõ´zuõÁµ[PøÍz 

öu›Äö\´x  öPõÒP.

 y uUPõÎ, Pzu›, ªÍPõ´ BQ¯Ú |ßS £Êzu  ¤ßÚº AÖÁøh 

ö\´x öPõÒP.

 y öÁsi, £¯ØÓ[Põ´ Gß£ÚÁØøÓz uõ´zuõÁµzv÷» |ßS 

•ØÔ E»º¢x ö|ØÖPÍõQ¯ ¤ßÚº AÖÁøh ö\´x öPõÒP.
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AÖÁøhPÎ¼¸¢x ÂzxUPøÍ ÷ÁÓõUPÀ 

ªÍPõ´  &   |ßS ]Á¨£õP¨ £Êzu Põ´PøÍ AÖÁøh ö\´x 

AÁØøÓU Pzv¯õÀ QÈzx ÂzxUPøÍ ÷ÁÓõUQU 

öPõÒP.

uUPõÎ &  |ßS £Êzu uUPõÎ¨ £Çzøu Pzv°ÚõÀ öÁmi 

ÂzxUPøÍ ÷ÁÓõUQ GkUPÄ®. ÂzxUPøÍ 

uizu xozxsiÀ Cmk |ßS Eµ]z ÷u´UPÄ®. 

A¨÷£õx ÂzxUPÎß ¦Óz÷u Põn¨£k® \Î¯® 

APØÓ¨£mh ¤ßÚº ÂzxUPÒ |ßS PÊÂ Áiz 

öukUP¨£k®.

Pzu›   &   |ßS £Êzu Pzu›UPõ´PøÍ AÖÁøh ö\´x Pzv 

¯õÀ ¤Í¢x ÂzxUPøÍ ÷ÁÓõUQ \Î¯¨£Sv 

APØÓ¨£k® ÁøP°À |ßS PÊÂ ÂzxUPøÍ 

ÁiPmi ÷ÁÓõUSP.

uõ´zuõÁµzv¾ÒÍ ÷£õ÷u Põ´PøÍ |ßS E»µ Âmk 

AÖÁøh ö\´u ö|ØÖUPøÍ Eøhzx ÂzxUPøÍ¨ 

ö£ÖP. ÷uøÁ¯õ°ß ö|ØÖU PÍõP÷Á E»ºzvU 

PÍg]¯¨£kzv øÁUPÄ® •i²®.

öÁsi  

£¯ØøÓ & 

ÂzxUPøÍ E»ºzxuÀ

 y Põ´PÎ¼¸¢x ÷ÁÓõUP¨£mh ªÍPõ´, uUPõÎ, Pzu› ÷£õßÓ 

ÂzxUPøÍ _zu©õÚ Phuõ]°À Cmk •u¼À ªu©õÚ 

öÁ°¼¾® Akzx \õuõµn öÁ°¼¾® Auß ¤ßÚº Ti¯ 

öÁ°¼¾®  |ßS E»ºzvU öPõÒÍ ÷Ásk®. J÷µ •øÓ°À 

Ti¯ öÁ¨£{ø»°À E»µÂmhõÀ ÂzxUPÒ _¸[QÂk®.

 y öÁsi, £¯ØøÓ ö|ØÖUPÎ¼¸¢x ÂzxUPøÍ¨ ¤›zöukzx 

|ßS öÁ°¼À E»ºzvU öPõÒÍ ÷Ásk®.

ÂzxUPøÍU PÍg]¯¨£kzuÀ

E»ºzv¯ ÂzxUPøÍ ÷£õzu¼À Cmk PõØÖ¨ ¦PõuÁõÖ CÖU 

P©õP ‰i E»º¢u SÎµõÚ ChzvÀ PÍg]¯¨£kzu ÷Ásk®. 

SÎ¹miPÎÀ PÍg]¯¨£kzv øÁ¨£uÚõÀ CÆÂzxUPøÍU 

Ti¯ Põ»zvØS ÷£o øÁzv¸UP •i²®.
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ªÍPõ´ ÂzxUPøÍz u¯õºö\´uÀ

uUPõÎ ÂzxUPøÍz u¯õºö\´uÀ

Pzu› ÂzxUPøÍz u¯õºö\´uÀ

 öÁsi ÂzxUPøÍz u¯õºö\´uÀ £¯ØÓ® ÂzxUPøÍz u¯õºö\´uÀ

]» \¢uº¨£[PÎÀ ]Ó¢u C¯À¦PÒ öPõsh uõ´zuõÁµzv¼¸¢x 

ö£ØÖUöPõÒÍ¨£k® ÂzxUPøÍ |kÁuß‰»® QøhUS® 

|õØÖ uõ´zuõÁµzvÀ Põn¨£k® AøÚzx¨ £s¦PøÍ²® 

öPõsi¸¨£vÀø». GÚ÷Á, £õ›¯ÍÂ»õÚ ÁoPŸv¯õÚ £°ºa 

ö\´øPUS ÂÁ\õ¯z vønUPÍzvß ‰»® Â{÷¯õQUP¨£k® 

|õØÖUPøÍ¨ ö£ØÖUöPõÒÁ÷u ö£õ¸zu©õÚuõS®.
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ÂzxUPøÍ |õØÖ÷©øh°¼hÀ

]» £°ºPøÍa ö\´øP £sq®÷£õx ÂzxUPÒ |õØÖ÷©øh°À 

Ch¨£mk Av¼¸¢x QøhUS® |õØÖUP÷Í PÍzvÀ |h¨£k®. 

Euõµn® & uUPõÎ, Pzu›, ªÍPõ´

¤k[Q |õmk®÷£õx ÷ÁºPÐUS HØ£k® £õv¨¦UPøÍz uõ[P 

•i¯õu £°ºPÎß ÂzxUPÒ ÷|µi¯õP Á¯¼À |õmh¨£k®.

Euõµn® & ÷£õg], £¯ØøÓ, §\Û, £õPÀ

Ãmkz÷uõmhzvÀ   |kÁuØSz ÷uøÁ¯õÚ  |õØÖUPøÍ¨  ö£ÖÁ 

uØS Ai¨£Sv°À xøÍ°h¨£mh ]Ô¯ \õiPÎÀ |õØÖ÷©øh 

CkuÀ ÷£õx©õÚx.

ö\¯Ø£õk 1.4 
ÂzxUPøÍ |õØÖ÷©øh°À Ck÷Áõ®

 y ÷uøÁ¯õÚ ö£õ¸mPÐ® E£Pµn[PÐ® 

 y |õØÖ÷©øh°¼h¨£mk |h¨£k® Âzx ÁøPPÒ ]» 

 y |õØÖa\õiPÒ (xøÍ°h¨£mh £øÇ¯ ö£mi, öÁØÖz u°ºa\

mi, öÁØÖ IìQÕ® \õi)

 y ÷©À ©s, Tmöh¸ AÀ»x E»º¢u ©õmöh¸

 y ]ÔuÍÄ øÁU÷PõÀ

 y \À»øh

 y øPUPµsi

 y §ÁõÎ

 y ]Ô¯ £õzvµ[PÒ

ÂzxUPøÍz u¯õº¨£kzuÀ 

 y £uº ÂzxUPøÍ }USuÀ & CuØöPÚ ÂzxUPÒ }º öPõsh 

£õzvµzvÀ Ch¨£mk ªuUS® ÂzxUPÒ }UP¨£mk }›À 

AªÊ® ÂzxUPÒ ©mk® öu›Ä  ö\´¯¨£h  ÷Ásk®.

 y ÂzxUPøÍ }›À FÓÂhÀ & •øÍ¨£uØSz ÷u øÁ ¯õÚ                          

}øµ APzxÔg]U öPõÒÁuØöPÚ ÂzxUPÒ }›À FÓÂh¨£h 

÷Ásk®. (12 ©ozv¯õ»® Áøµ)
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|õØÖ÷©øh FhPzøuz u¯õºö\´uÀ

÷©À ©s, Tmöh¸ BQ¯ÁØøÓa \À»øh°ß ‰»® A›zöukU 

PÄ® ÷©À©s, Tmöh¸ BQ¯ÁØøÓ 1:1 GßÓ ÂQuzvÀ P»¢x 

FhPzøuz u¯õºö\´P. 

ÂzxUPøÍ |kuÀ

4.\õiø¯ øÁU÷Põ»õÀ ‰i 

§ÁõÎ°ÚõÀ }¹ØÖuÀ

5. ÂzxPÒ  •øÍUPz öuõh[ 

Q¯x® øÁU÷PõØ £øhø¯ 

APØÖuÀ

2. Auß «x  ^µõP ÂzxU  

PøÍ CkuÀ

3. ÂzxUPÎß «x  ö©À 

¼¯ £øh¯õP  |õØÖ 

÷©øh  FhPzøu  

CkuÀ 

1.\õi°ÝÒ |õØÖ÷©øh 

FhPzøu {µ¨¦uÀ

|õØÖ÷©øh FhP® E»µõv¸UP §ÁõÎ°ÚõÀ }º FØÓ¨£h 

÷Ásk®. ÂzxUPÒ •øÍUPz öuõh[Q¯x® øÁU÷PõØ£øh 

APØÓ¨£mk  |ßS ̀ ›¯JÎ QøhUS® ChzvÀ \õi øÁUP¨£h 

÷Ásk®. ‰ßÖ Áõµ[PÎÀ |õØÖUPÒ PÍzvÀ |hUTi¯uõP 

C¸US®.
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uskz xsh[PøÍ ÷ÁºÂha ö\´uÀ

]» uõÁµ[PÎÀ uskz xsh[PÎ¼ 

¸¢÷u |õØÖUPÒ ö£Ó¨£k®. AÆÁõ 

ÓõÚ ]» £°ºPÎß uskz xsh[PÒ 

÷|µi¯õP PÍzvÀ |h¨£k®. 

Euõµn® & ÁØÓõøÍ, P[Sß, ©µÁÒÎ, 

ö£õßÚõ[Pso

]» £°ºPÎß uskz xsh[PÒ |õØÖ 

÷©øh°¼h¨£mk ÷ÁºÂha ö\´¯¨ 

£mh ¤ßÚ÷µ Á¯¼À ©õØÔ |h¨£k®. 

Ãmkz÷uõmhzv¾ÒÍ {»zv÷»õ                 

\õi°÷»õ uskz xsh[PøÍ ÷ÁºÂhaö\´x |õØÖUPøÍ¨ 

ö£Ó•i²®. \õi°À AÀ»x xøÍPÒ  öPõsh AP»©õÚ £õz 

vµzvÀ AvP GsoUøP°À uskzxsh[PøÍ ÷ÁºÂha ö\´ 

¯»õ®.

      ÷ÁºÂha ö\´ÁuØöPÚ |õmh¨ 

£mkÒÍ uskzxsh[PÒ

ö\¯Ø£õk 1.5
uskz xsh[PøÍ ÷ÁºÂha ö\´÷Áõ®

÷uøÁ¯õÚ ö£õ¸mPÐ® E£Pµn[PÐ®

 y |õØÖa\õiPÒ (£øÇ¯ £õzvµ[PÒ, 

öÁØÖz u°ºa\mi, IìQÕ®  ö£mi

 y ÷©À©s, Tmöh¸/ E»º¢u ©õmöh¸ ©nÀ

 y ö»©ß uõÁµUQøÍ

 y \À»øhzumk, øPUPµsi, §ÁõÎ, 

AP»©õÚ   ÷©Ø£Svø¯U öPõsh ]» 

£õzvµ[PÒ 

£i•øÓ & 1
\õiPÎß  Em£Sv°À xøÍPøÍ CmkU öPõÒP. A›zöukU 

P¨£mh ÷©À©s, Tmöh¸, ©nÀ BQ¯ÁØøÓ 1:1:1 GßÓ 

ÂQuzvÀ P»¢x FhPzøuz u¯õ›zx \õiPÎÀ {µ¨¤U 

öPõÒP. 

JmkÁuØS u¯õº£kz 

u¨£mh uskz xsh 

ö©õßÖ
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£i•øÓ & 2

A÷ÚP©õP |kzuµ •vºa] öPõsh uskz 

xsh[P÷Í |kÁuØS EP¢uÚÁõS®. |kÁuØ 

PõP¨ £¯ß£kzu¨£k® uskzxsh©õÚx 

£» PqUPøÍU öPõshuõP C¸¨£x ªP¨ 

ö£õ¸zu©õÚuõP Aø©Áxhß E¸ÂÀ Põmh¨ 

£mkÒÍÁõÖ PqÂØSU RÇõP Asø©°À               

\õ´ÁõP öÁmiz usøhz u¯õºö\´x öPõÒÍ 

÷Ásk®. C¢uz uskz xsh[PøÍ FhP® 

{µ¨£¨£mh \õi°À |hÄ®. ÷ÁºÂk® Áøµ°À {Ç»õÚ 

Chö©õßÔÀ øÁUPÄ®. ÷uøÁ¨£k® \¢uº¨£zvÀ }º FØÓ 

÷Ásk®.

uskz xshö©õßÖ 

|h¨£mkÒÍ •øÓ

{»URÌz uskz xsh[PÎ¼¸¢x |õØÖUPøÍ¨ ö£ÖuÀ

]» uõÁµ[PÎß usk uøµ°ßRÌ Põn¨£k®. CøÁ {»URÌz 

uskPÒ GÚ AøÇUP¨£k®.

Euõµn® & ©g\Ò, Cg], ÁõøÇ, Cµõ\ÁÒÎ

ö£õxÁÇUQÀ CøÁ QÇ[SPÒ  GÚU SÔ¨¤h¨£kQßÓ ÷£õx® 

Esø©°À CøÁ uõÁµzvß usk¨ £SvPÍõS®. CÆÁõÓõÚ 

{»URÌz uskPøÍ xsh[PÍõUQ |kÁuß ‰»® |õØÖUPøÍ¨ 

ö£Ó •i²®. CøÁ ö£õxÁõP ÷|µi¯õP÷Á PÍzvÀ |h¨£kÁxhß 

\õiPÎ¾® |õmi |õØÖUPøÍ¨ ö£ØÖUöPõÒÍ •i²®. 
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ö\¯Ø£õk 1.6  

{»URÌz uskz xsh[PÎ¼¸¢x |õØÖPøÍ¨ ö£ÖuÀ

÷uøÁ¯õÚ ö£õ¸mPÐ® E£Pµn[PÐ®

● |õØÖa\õiPÒ (£øÇ¯ £õzvµ[PÒ, öÁØÖ¨ £õÀ©õ EøÓ, 

öÁØÖ IìQÕ® ö£mi)

● ÷©À©s, Tmöh¸ AÀ»x E»º¢u ©õmöh¸, ©nÀ

● ©g\Ò AÀ»x Cg]z xsh[PÒ ]»

● \À»øhz umk, øPUPµsi, §ÁõÎ, AP»©õÚ ÷©Ø£Svø¯U 

öPõsh £õzvµ®

£i•øÓPÒ

1' {»URÌz uskPøÍ |k®÷£õx ö\¯Ø£õk 1.5 Cß £i•øÓ    

1 CÀ ÷©ØöPõshÁõÖ \õiPøÍ {µ¨¦P.

2'  öu›Ä  ö\´¯¨£mh  QÇ[øP  ]Ö 

     xskPÍõP  öÁmkuÀ

3' {µ¨¤¯ FhPzvß «x   

QÇ[Sz xskPøÍ 

øÁzuÀ

4' Auß«x ]ÔuÍÄ  FhPzøu Cmk   

¤ßÚº øÁU÷PõÀ Cmk }øµ FØÖuÀ

5' QÇ[Sz xsh[PÒ •øÍ  

Âh¨£mh ¤ßÚµõÚ {ø»
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£°ºaö\´øP¨ £iÁö©õßøÓz vmhªk÷Áõ®

]Ô¯ AÀ»x £õ›¯ÍÁõÚ Ãmkz ÷uõmhö©õßøÓ¨ ÷£q® 

ö£õÊx AuØS¨ £¯ß£kzu¨£k® ö£õ¸mPÒ, vÚ¢÷uõÖ® 

÷©ØöPõÒÍ¨£k® |hÁiUøPPÒ ÷£õßÓÚ öuõhº£õP £vÄPÒ 

øÁzv¸¨£x ªP •UQ¯©õÚuõS®.

Ãmkz ÷uõmhö©õßøÓ¨ ÷£qÁuØSz ÷uøÁ¯õÚ EÒÏkPÍõÚ 

ÂzxUPÒ, |õØÖUPÒ, £\øÍ, }º, ©Ûu EøÇ¨¦ Gß£ÁØÖhß 

uøµø¯ JÊ[Pø©zuÀ, |õØÔkuÀ, |õØÖUPøÍ |kuÀ ÷£õßÓ 

ö\¯Ø£õkPÐhß AÆÁõÓõÚ EÒÏkPÐUöPÚ HØ£mh ö\»ÄPÒ 

öuõhº£õPÄ® £vÄö\´x øÁzu»õÚx öÁØÔPµ©õP Ãmkz 

÷uõmhzøu¨ £µõ©›¨£uØSz xøn¯õP Aø©QßÓx.

|õ®, C¢u Azv¯õ¯zvÀ Âzx EØ£zva ö\¯ß•øÓ°À Dk£ 

k÷Áõ®. Caö\¯ß•øÓUS HØÓÁõÖ £°ºaö\´øP¨ £iÁö©õß 

øÓz u¯õ›US® •øÓ öuõhº£õPU PÁÚ® ö\¾zx÷Áõ®.

£°ºaö\´øP¨ £iÁö©õßøÓz u¯õ›US® ö£õÊx ¤ßÁ¸® C¸ 

£i•øÓPÒ ¤ß£ØÓ¨£h ÷Ásk®.

 y Phuõ]z uõÎÀ (HkPÎÀ AmhÁøn¨£kzuÀ)

 y PoÛ°ß xønöPõsk £°ºaö\´øP¨ £iÁö©õßøÓz 

u¯õ›zuÀ 

E[PÍx £õh\õø»°À PoÛÁ\v Põn¨£k©õ°ß CµshõÁx 

•øÓø¯¨ £¯ß£kzu»õ®.

PoÛ°ß xøn²hß £°ºaö\´øP¨ £iÁö©õßøÓz 

u¯õ›zuÀ

CuØPõP ö\õÀ •øÓÁÈ¨£kzuÀ ^Word Processing& ö©ßö£õ¸Ò

£¯ß£kzu¨£k®. £õh\õø»U PoÛ B´ThzvÀ £¯ß£kz 

u¨£kQßÓ PoÛ¨  £oö\¯À •øÓø©PÒ (Operating System)
Cµsk EÒÍÚ. 

y Microsoft Office £oaö\¯À•øÓ°À Microsoft Office Word ö\õÀ 

•øÓ ÁÈ¨£kzuÀ ö©ßö£õ¸Ò

y Isuru Linux £oaö\¯À •øÓø©US›¯ Libre Office writer ö\õÀ 

•øÓÁÈ¨£kzuÀ ö©ßö£õ¸Ò
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£°ºaö\´øP¨ £iÁz u¯õ›¨¦UöPÚ LibreOffice writer GÝ® ö©ß 

ö£õ¸øÍ¨ £¯ß£kzx÷Áõ®.

LibreOffice ö©ßö£õ¸ÎÝÒ ¤µ÷Á]¨£uØPõP "" Dash Home’’ 
GÝ® £hÄ¸Âß«x AÊzx®÷£õx QøhUS® ÷uhÀ vøµ°ß 

«x writer GÚz umha_a ö\´Áuß ‰»÷©õ AÀ»x PoÛz 

vøµ°ß «x Põn¨£k®   GÝ® £hÄ¸Âß «x AÊzxÁuß 

‰»÷©õ LibreOffice writer ö©ßö£õ¸ÎÀ ¤µ÷Á]UP •i²®. 

A®ö©ßö£õ¸ÍõÚx Põm]¨£kzu¨£k® ö£õÊx QøhUQßÓ 

xøn •P¨¦ R÷Ç uµ¨£mkÒÍx. 

Czxøn •P¨¤À EÒÍ {¯©U P¸Â¨ £møh (Standard Toolbar),
÷Põ»U P¸Â¨ £møh (Formatting Toolbar) Gß£Ú  öuõhº£õP }[PÒ 

ÂÍUPzøu¨ ö£ØÖÒÏºPÒ.

ö\õÀ •øÓÁÈ¨£kzuÀ  ö©ßö£õ¸Îß xøn²hß Amh 

Áønö¯õßøÓz  u¯õ›¨÷£õ®

CuØPõP ö©ßö£õ¸Îß ö©Ý vøµ°ß (Menu Bar) «x Põn¨£k®

Table → Insert → Table → Enter ö\´Áuß ‰»® Insert → Table 
AmhÁøn QøhUS®.
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Insert → Table ö\õÀ»õhÀ \õÍµ®

C[S Name Gß£uØS •ßÚõÀ Põn¨£k® \mhPzvÀ AmhÁ 

ønUS›¯ ö£¯øµz  umha_a ö\´¯Ä®. Columns Gß£uØS 

•ßÚõÀ Põn¨£k® \mhPzvÀ AmhÁønUSz ÷uøÁ¯õÚ 

{µÀPÎß GsoUøPø¯U SÔ¨¤mkU PõmhÄ®. Rows Gß£uØS 

•ßÚõÀ Põn¨£k® \mhPzvÀ AmhÁønUSz ÷uøÁ¯õÚ 

Á›ø\PÎß GsoUøPø¯U SÔ¨¤hÄ®. ÷©ØPõmi¯ ö£Ö©õ 

Ú[PøÍ ÁÇ[Q¯ ¤ßÚº OK ö\´²®ö£õÊx E[PÐUSz 

÷uøÁ¯õÚ AmhÁøn Qøh¨£xhß AÆÁmhÁøn°ß ÷Põ» 

Aø©¨¤À ©õØÓ®ö\´¯ ÷Ásk©õ°ß Table Toolbar CøÚ¨ £¯ß 

£kzu ÷Ásk®.
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÷©÷» CÚ[Põn¨£mh P¸Â¨ £møhPÒ «x _miø¯ øÁzv 

¸US® ö£õÊx Tool Tip  QøhUQßÓx. Cuß‰»® PmhøÍø¯ 

AÔ¢xöPõÒÍ •i²®. A÷u÷£õßÖ A[S Põn¨£k® Aøh¯õ 

Í[PÒ ÂÍUPzøu¨ ö£ØÖUöPõkUS®.

÷©»vP {µÀPÒ AÀ»x Á›ø\PøÍa ÷\º¨£uØPõP Insert Row/
Insert columnø© ²® ÷u øÁ ¯ØÓ {µÀP øÍ²® Á›ø\P øÍ ²®                                      

}USÁuØPõP, }USÁuØSz ÷uøÁ¯õÚ {µ¼À AÀ»x Á›ø\°ß 

«x Põmiø¯¨ (Delete Row/Delete column) £¯ß£kzv AUP¸©zøu 

{øÓ÷ÁØÔU öPõÒÍ •i²®.

ö\¯Ø£õk 1.7

 y E[PÍõÀ ÷©ØöPõÒÍ¨£k® ö\¯Ø£õkPÒ öuõhº£õP 

A¨¤¯õ\¨ ¦zuPö©õßÔÀ £vÄö\´x öPõÒÍÄ®. CuØS 

Euõµn©õPU R÷Ç Põmh¨£mkÒÍ AmhÁønø¯¨ 

£¯ß£kzuÄ®.

 y E[PÍx £õh\õø»°À PoÛÁ\v Põn¨£k©õ°ß 

PoÛ°ß xøn²hß uPÁÀPøÍ AÔUøP¨£kzuÄ®.

vPv ö\¯Ø 

£õk

\¢uº¨£® \¢vzu ¤µa    

]øÚPÒ

£¯ß£kzv¯ 

wºÄPÒ

÷ÁÖ 

Âh¯[ 

PÒ

2015' 

02'03

ÂzxU 

PøÍ 

|õØÖ 

÷©øh 

°¼hÀ

|õØÖ 

÷©øh°  

¼h¨ 

£mh 

ÂzxPÒ 

•øÍ¨£ 

uØS 

•ßÚº

£ÓøÁPÒ

ÂzxUPøÍ 

Gkzxa 

ö\À»À

}ºzöuõmi 

ö¯õßÔÀ 

øÁUP¨£mh  

©µUSØÔö¯õ 

ßÔß 

«x |õØÖ  

÷©øha                  

\õiø¯ 

øÁzuÀ



22 C»Á\¨ £õh¡À

1.2 £õh\õø» ÁÍÂÀ uøµ¯»[P›¨ø£ ÷©ØöPõÒ÷Áõ®

C¢u E£ Azv¯õ¯zøuU PØ£uß ‰»®,

 y £õh\õø» ÁÍÂß Aø©ÂØS¨ ö£õ¸¢uUTi¯ ÁøP°À 

A»[P›¨¦z vmh Áøµø£z u¯õ›UPÄ®

 y uøµ¯»[P›¨¤ØS¨ £¯ß£kzu¨£k® uõÁµ[PøÍ CÚ[ 

PõnÄ®

 y £À÷ÁÖ Ch[PÐUS¨ ö£õ¸zu©õÚ uõÁµ[PøÍz 

wº©õÛ¨£uØS®

 y öu›Ä ö\´u uõÁµ[PÎÚõÀ BØÓ¨£k® P¸©[PøÍ 

ÂÍUPÄ®

 y £À÷ÁÖ uøµ¯»[P›¨¦U Pmhø©¨¦PøÍz öu›Äö\´¯Ä®

 C¯¾©õS®.

`Çø» A»[Põµ©õP¨ ÷£qÁuß ‰»® |õ® AøÚÁ¸® ©QÌa]

ø¯¨ ö£Ó •i²®. AÆÁõ÷Ó £õh\õø» ÁÍøÁ²® A»[Põµ©õP¨ 

÷£qÁuØS¨ £[PÎ¨¦a ö\´Áuß ‰»® EÍzv¸¨vø¯¨ 

ö£ØÖUöPõÒÍÄ® •i²®.

                 

uøµ¯»[P›¨¦UPõP¨ £¯ß£kzu¨£k® TÖPÒ ¤µuõÚ©õP 

Cµsk ÁøP¨£k®.

  ² ö©ß TÖPÒ 

  ² Áß TÖPÒ  

uøµ¯»[P›¨¤ß÷£õx £¯ß£kzu¨£k® uõÁµ[PÒ, £ÓøÁPÒ, 

Ásnzx¨ §a]PÒ ÷£õßÓ AøÚzx® J¸[÷P ö©ßTÖPÒ GÚ 
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AøÇUP¨£k®. uøµ¯»[P›¨¦UöPÚ¨ £¯ß£kzu¨£k® E°µØÓ 

TÖPÒ ÁßTÖPÒ GÚ AøÇUP¨£k®.

 y ö©ß TÖPÒ :- uøµ A»[P›¨¤ß ÷£õx ö©ß TÖPÍõP 

¤µuõÚ©õP uõÁµ[PøÍ |kÁ÷uõk, AuØS Á¸® E°›Ú[PÐ® 

Th uøµ A»[PõµzvøÚU öPõsk u¸®.

uøµ¯»[P›¨¤À uõÁµ[PøÍ¨ £¯ß£kzxÁuß ÷|õUP[PÒ

²  {ÇÀ QøhzuÀ 

B»©µ® ©µ® ÷£õßÓ £õ›¯ ©µ[PøÍ |kÁuß ‰»® {ÇÀ 

QøhUS®.

²  ¦ÓUPõm]US¨ ö£õ¸zu©ØÓ Ch[PÎÀ ©øÓ¨ø£ HØ£kzuÀ 

PÈ¨£P[PÒ, }ºzuõ[Q ÷£õßÓÁØøÓ, E¯µ©õÚ ©µ[PøÍ 

ö|¸UP©õP |kÁuß ‰»® ©øÓUP •i²®.

² `Çø»U PÁºa]Pµ©õÚuõUSuÀ  

C[S £À÷ÁÖ Áºn[PÐhß Ti¯ ö\iPÒ, ©µ[PÒ  ÷£õßÓÚ 

|h¨£k®. 

² `Çø» |Ö©n® öPõshuõUSuÀ  

|Ö©n ©»ºPÒ öPõsh ©À¼øP, PõjÛ¯õ, öÁ\õU § ÷£õßÓ 

uõÁµ[PøÍ |õmkÁuß ‰»® `Ç¼À |Ö©n® Ã_®. 

² S¸ÂPÒ, Ásnzx¨ §a]PÒ BQ¯ÁØøÓ Áµaö\´uÀ 

S¸ÂPÒ EnÁõP EmöPõÒÐ® £Ç[PÒ öPõsh uõÁµ[PÒ, 

÷uß Põn¨£k® ©»ºPøÍ²øh¯ uõÁµ[PÒ BQ¯ÁØøÓ 

|õmkuÀ.

² EnÄUPõP¨ £¯ß£hÀ

ö£õßÚõ[Pso, ÁÀ»õøµ, •øÍURøµ, ÷PõÁõ ÷£õßÓÁØ 

øÓ²® £ßÛÓ•® £À÷ÁÖ ÁiÁ[PøÍU öPõshx©õÚ 

Pzu›, ªÍPõ´ ÁøPPøÍU öPõsh uõÁµ[PøÍ |kÁuß ‰»® 

A»[Põµ®  Qøh¨£xhß EnÄUS® £¯ß£k®.

uøµ¯»[P›¨¦UöPÚ¨ £¯ß£kzu¨£k® uõÁµ[PÒ

ö©ß TÖPÍõP¨ £¯ß£kzu¨£k® uõÁµ[PÒ £À÷ÁÖ ÁøP¨£k®. 

uõÁµ[PÎß £¸©ß, ÁÍºa]U÷Põ»® BQ¯ÁØÖUPø©¯Ä® 

©»ºPÐUPø©¯Ä® £À÷ÁÖ ÁøP¨£mh ußø©PÎÀ Põm] 
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öPõkUQßÓÚ. ÷uøÁUPø©¯ £À÷ÁÖ •øÓPÎÀ Cz uõÁµ[PÒ 

£¯ß£kzu¨£k®.

uøµ¯»[P›¨¤ß÷£õx uõÁµ[PÒ £¯ß£kzu¨£k® £À÷ÁÖ 

•øÓPÒ

  ² ö£¸©µ[PÒ (large trees)
  ² ¦uºPÒ (shrubs) 
  ² uõÁµ ÷Á¼PÒ ^hedges)
  ² ÂÎ®¦PÒ ^borders)  

  ² ‰k £°ºPÒ (cover crops)
² ö£¸©µ[PÒ 

E+®:- ¥Pì (B»©µ ÁøP) öPõßøÓ, ÂÍõzv, á®¦, öPõ´¯õ, 

öÁµÎ ©µ®, uõ» (£õ®) ÁøPz uõÁµ[PÒ, Song of india

¥Pì ö£ßáªÚõöPõßøÓ

² £ØøÓ¯õP ÁÍ¸® uõÁµ[PÒ 

E+®:-   ÷µõ\õ,  ö\ÆÁµzøu,  {zv¯PÀ¯õo,  YTT" ÷£õPßÂ»õ, 

•ö\ßhõ, ÷£õÂØÔ¯õ, PõjÛ¯õ, möµ^Úõ ÁøPPÒ 

  YTTmöµ^Úõ PõjÛ¯õ
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² uõÁµ ÷Á¼PÒ ^hedges)
~øÇÁõ°¼ß C¸©¸[Q¾® Põo°ß GÀø»÷¯õµ[PÎ¾® 

uõÁµ ÷Á¼PÒ Aø©UP¨£k®.

Cµsk {µÀPÒ öPõsh uõÁµ[PÒ 

£¯ß £kzu¨ £mkÒÍ •øÓ
ö\ÆÁµzøu uõÁµ÷Á¼

CU÷\õµõ ÷Á¼÷PõÀhß  xµßuõ ÷Á¼

² ÂÎ®¦PÒ ^borders) 
£À÷ÁÖ Ch[PÎÀ GÀø»PøÍz öuÎÁõPU PõmhÄ® |øh£õøu 

°ß  C¸©¸[Q¾® A»[PõµzxUPõP Smøh¯õÚ uõÁµ[PÎÚõÀ 

ÂÎ®¦PÒ Aø©UP¨£k®. 

÷Põ¼¯õì ÂÎ®¦PÒ ÷µõî÷¯õ ÂÎ®¦
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²  ‰k £°ºPÒ

E+®:& ¦À ÁøPPÒ, öÁõsh›[ áú ^wandering jew&" G¨¥]¯õ 

CÚ[PÒ, £À÷ÁÖ {Ó Cø»PÒ öPõsh ÁØÓõøÍPÒ 

G¨¥]¯õ

£À÷ÁÖ {Ó Cø»PÒ öPõsh ÁØÓõøÍ CÚ[PÒ

öÁõßh›[ áü

¦ÀÁøP

]Ö ¦À»i

² ÁiÁø©UP¨£mh  uõÁµ[PÒ

Pzu›zx ÁiÁø©UP¨£mh £À÷ÁÖ uõÁµ[PÒ uøµ A»[P›¨ 

¦UöPÚ¨ £¯ß£kzu¨£k®.

ÁiÁø©UP¨£mh ©µ® uõÁµ ÁiÁø©¨¤ß ‰»® E¸ÁõUP¨£mh 

{¸©õo¨¦
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A÷u÷£õßÖ ÷uøÁUPø©¯ ©»ºz uõÁµ[PÒ, §UPõu uõÁµ[PÒ 

Gß£ÁØøÓ²® £¯ß£kzu •i²®.

²  §US¢ uõÁµ[PÒ

   E+® :-  ö\ÆÁµzøu, ÷µõ\õ, CU÷\õµõ, A¢y›¯®,÷£õPßÂ»õ

÷£õPßÂ»õ í´möµßâ¯õ ^Û¯õì

²  §UPõu uõÁµ[PÒ

E+® :- P÷»v¯õ, Cø» A»[Põµ vµ]Úõ, ÷Põ¼¯õì, ìø£hº    

¤ÍõßØ, £ßÚz uõÁµ[PÒ, Cø»¯»[Põµ ÷\®¦

£ßÚz uõÁµ®Cø» A»[Põµ ÷\®¦P÷»v¯õ

 

uøµ¯»[P›¨¤À £¯ß£kzu¨£k® ÁßTÖPÒ 

 y P¸[PÀ 

 y TøÇUPÀ

 y £iUPÀ (^ö©¢x AÀ»x ©µzvÚõ»õÚ)

 y C¸UøP (^ö©¢x AÀ»x ©µzvÚõ»õÚ) 

 y £õ»® (^ö©¢x AÀ»x ©µzvÚõ»õÚ)

 y ÷Á¼PÒ (^ö©¢x AÀ»x ©µzvÚõ»õÚ)

 y ÂÀ ÁiÁ ÁøÍÄ (^ö©¢x AÀ»x ©µzv»õÚ)

 y ]ø»PÒ/]Ø£[PÒ

 y C»õ®¦PÒ

 y ÂÍUSPÒ
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 y £ÓøÁU SÎ¯À öuõmi

 y £ÓøÁPÎØPõÚ EnÄ¨ £õzvµ®

 y uhõP®

 y  }ºÃÌa] 

P¸[PØPøÍ¨ £¯ß£kzv A»[P›zuÀ TøÇUPØPøÍ¨  £¯ß£kzv  ÷©ØöPõÒÍ¨ 

£mh A»[P›¨¦

¦ØÓøµ°À £iUPØPøÍ¨ £¯ß£kzv 

A»[P›zuÀ

£µÀPÒ Ch¨£mh Ãv°À £iUPØPÒ 

Ch¨£mk A»[P›UP¨£mi¸zuÀ

Ai øÁzx |h¨£uØS ©µU 

SØÔPøÍ¨ £¯ß£kzuÀ

C¸UøPPÍõP ©µUSØÔPÒ £¯ß£kzu¨£mkÒÍ Âu®
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ÂÀÁiÁ ÁøÍÄ uhõP•® £õ»•®

¦ØÓøµ°À £iUPÀ Áõ[SPøÍ¨ 

£¯ß£kzv A»[P›zuÀ

÷Á¼ Aø©zuÀ

£ÓøÁPÐUPõÚ SÎ¯À öuõmi}ºÃÌa] 

§¢÷uõmh ÂÍUS   ]ø»PÒ øÁUP¨£mkÒÍ Âu®
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ö\¯Ø£õk 1'8 

    uøµ¯»[P›¨¦UPõÚ ÁÍ[PøÍ¨ ö£ØÖU öPõÒ÷Áõ®

 E[PÍx £õh\õø»a `Ç¼À ö£ØÖUöPõÒÍU Ti¯ £À÷ÁÖ ö©ß, 

Áß TÖPÒ £ØÔ¯ uPÁÀPøÍa ÷\P›zx R÷Ç Põmh¨£mkÒÍ 

AmhÁønUPø©¯ E[PÍx £°Ø]¨ ¦zuPzvÀ SÔzxU öPõÒÐ[PÒ.

 ö£õ¸ÒPÒ TÖPÎß ußø©

ö©ß/ Áß

uøµ A»[P›¨¤ß ÷£õx 

£¯ß£kzuU Ti¯ •øÓ

{¯©•øÓ,  {¯©ªÀ •øÓ°»õÚ  uøµ¯»[P›¨¦UPÒ

ö©ß, Áß TÖPøÍ uøµ°À JÊ[Pø©US® ÂuzxUPø©¯ 

uøµ¯»[P›¨¦ •øÓPÒ Cµsk ÁøP¨£k®. 

1' {¯©•øÓz uøµ¯»[P›¨¦

Cx {¯© ÁiÁ[PÎÀ JÊ [S •øÓUPø©¯ Aø©UP¨£mhuõS®. 

C[S ÁÍºUP¨£k® uõÁµ[PÒ  £À÷ÁÖ  ÁiÁ[PÎÀ  Pzu›UP¨ 

£mi¸¨£xhß  Ámh®, \xµ®  ÷£õßÓ  ÷PzvµPou  ÁiÁ[ 

PÎÀ  £õzvPÒ, uhõP®, uõÁµ ÷Á¼PÒ ÷£õßÓÚ Aø©UP¨£mk 

JÊ[S •øÓUPø©¯ uøµ A»[P›UP¨£mi¸US®. 

{¯©ªÀ•øÓz  uøµ¯»[P›¨¦ 

C[S C¯À£õP÷Á uõÁµ[PÒ ÁÍµ Ch©ÎUP¨£k®. uhõP®, 

|øh£õøu, ÷Á¼PÒ BQ¯Ú JÊ[PØÓ•øÓ°À Põm]¯ÎUPU 

Ti¯ÁõÖ Aø©UP¨£mi¸US®. 
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ö\¯Ø£õk 1'9

£õh\õø» ÁÍÂÀ uøµ¯»[P›¨¦US¨ ö£õ¸zu©õÚ Chzøuz öu›Ä 

ö\´÷Áõ®.

E[PÍx £õh\õø» B]›¯¸hß ÷\º¢x £õh\õø» ÁÍøÁ |ßS AÁuõ 

Ûzx A»[P›UPUTi¯  Ch[PøÍz öu›Äö\´P. AÆöÁõÆöÁõ¸ 

Ch•® ö£õ¸zu©õP C¸¨£uØS AÀ»x ö£õ¸zu©ØÓuõP C¸¨£uØPõÚ 

PõµnzøuU SÔ¨¤kP. ¤ßÁ¸® AmhÁøn°À Ax öuõhº£õÚ ÂÁµ[ 

PøÍ GÊv E[PÍx £°Ø]¨ ¦zuPzvÀ AuøÚ¨ ¤µv ö\´x öPõÒP.

{ø»¯® / Ch® ö£õ¸zu©õÚ 

{ø»ø©PÒ

ö£õ¸zu©ØÓ 

{ø»ø©PÒ

öu›Ä 

ö\´uÀ

E+® &  B ´Th                      

•Ø£Sv

£õh\õø» 

~øÇÁõ°¾Sz 

öuÎÁõP¨ 

¦»¨£hÀ

uøµ°ß RÌ 

ö£õ¸zu¨£mh  

}ºUSÇõ´ EÒÍx

      

£õh\õø» ÁÍøÁ A»[P›US®÷£õx PÁÚzvØöPõÒÍ ÷Ási¯ 

Âh¯[PÒ

1. £¯ß£kzu¨£k® uõÁµ[PÒ ¤µ÷u\ Põ»{ø»US¨ ö£õ¸zu©õP 

Aø©uÀ

E»ºÁ»¯¨ £õh\õø»PÎÀ uøµ¯»[P›¨ø£ ÷©ØöPõÒÐ®÷£õx 

PiÚ©õÚ `Ç¾USz uõUS¨¤iUPU Ti¯ uõÁµ[PÒ öu›Ä 

ö\´¯¨£h ÷Ásk®.

E+® & ÷£õPßÂ»õ, A»›
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`ÇÀ öÁ¨£{ø» SøÓÁõÚ Ch[PÐUS ö£÷Põo¯õ, £ßÚz 

uõÁµ[PÒ ÷£õßÓÚ |h¨£kÁx ªP¨ ö£õ¸zu©õÚuõS®. öu›Ä 

ö\´u Ch® {ÇÀ öPõshöuÛß {Çø» Â¸®¦® uõÁµ[PÍõÚ 

P÷»v¯õ, ö£¨£÷µõª¯õ ÷£õßÓÁØøÓz öu›Äö\´¯ ÷Ásk®.

2'  {»zvß ußø©

{»zvß  Aø©ÄU÷PØ£  A[S Em£kzu¨£k® TÖPÐ® 

÷Á Ö£k®. \© uøµ ö¯Ûß ¦ØÓøµ ‰»®  A»[P ›UP»õ® .                                        

\õ´ÁõÚ {»[PÎÀ ¦ØÓøµ Aø©UP¨£mhõÀ A»[Põµ©õPU 

Põm]¯ÎUPõx.

3' ö£ØÖUöPõÒÍUTi¯ ÁÍ[PÎß ÁøPPÐ® AÍÄ®

A¯Ø`Ç¼¾ÒÍ ÁÍ[PøÍ¨ £¯ß£kzxÁx  ]Ó¢uuõS®.  P¸[ 

PÀ, ©µUSØÔPÒ BQ¯ÁØøÓ¨ ö£ÓUTi¯ ¤µ÷u\[PÎÀ AÆÁõ 

ÓõÚ TÖPøÍ¨ £¯ß£kzxÁx ªPÄ® ö£õ¸zu©õÚuõS®. PØPÒ 

£µÁ»õPU Põn¨£k® ¤µ÷u\[PÎÀ PØ§[PõUPøÍ Aø©UP»õ®.

4' ö\»ÂhzuUP {v°ß AÍÄ

`Ç¼¼¸¢x C»Á\©õP¨ ö£ØÖUöPõÒÍU Ti¯ ö£õ¸mPÐUS 

÷©»vP©õP HøÚ¯ Áß, ö©ß TÖPÐUPõP¨ £n® ö\»Âh¨£h 

÷Ási HØ£iß £õh\õø»°Úx ö£õ¸Íõuõµ C¯¾ø© 

öuõhº£õPU PÁÚ® ö\¾zu ÷Ásk®. 

5' Dk£kzuUTi¯ EøÇ¨¦ 

E[PÐUS EuÄÁuØS Á¯x •vº¢÷uõº AÀ»x FÈ¯ºPÒ 

C¸¨£õºP÷Í¯õÚõÀ AuÚi¨£øh°À {ÖÄÁuØS Ez÷u]US® 

TÖPÒ öuõhº£õP wº©õÛUP ÷Ásk®. £õ›¯ ©µUSØÔPÒ, ö£›¯ 

PØPÒ BQ¯ÁØøÓ¨ £¯ß£kzu •Ø£mhõÀ E[PÍx £õxPõ¨¤ØS 

Aa_Özu»õP Aø©¯UTk®.

uøµ¯»[P›¨¦a ö\¯ß•øÓ°ß £i•øÓPÒ

E›¯ {»zvß ußø©PøÍ Bµõ´uÀ

C[S P¸zvØ öPõÒÍ¨£h ÷Ási¯ £» PõµoPÒ EÒÍÚ

1' {»zv¼¸¢x •Êø©¯õP APØÓ¨£h ÷Ási¯ ö©ß, Áß 

TÖPøÍz wº©õÛzuÀ.
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2' EÒÍ Chzv÷»÷¯ Âh¨£h ÷Ási¯ TÖPøÍz ÷ui¯ÔuÀ.

3' Chzøu ©õØÔ «sk® {ÖÁ¨£h ÷Ási¯ TÖPøÍ 

CÚ[PõnÀ.

4' {»zvÀ ¦vuõP EÒÍhUP¨£h ÷Ási¯ TÖPÒ GøÁö¯ß 

£øuz  wº©õÛzuÀ.

5' ÷©Ø£i Âh¯[PøÍ EÒÍhUQ¯uõP  £¸©mhõÚ vmh¨ 

£hzøu ÁøµuÀ.

6' öu›Äö\´¯¨£mh ö©ß, Áß TÖPøÍz vmhªh¨£mh {ø» 

¯[PÎÀ {ÖÄuÀ. 

ö\¯Ø£õk 1'10

 uøµ¯»[P›¨¦UPõÚ vmhzøu Áøµ÷Áõ®

÷uøÁ¯õÚ ö£õ¸mPÒ/ E£Pµn[PÒ

 A4  AÍÁõÚ  öÁÒøÍz  uõÒ

 ö£ß]À 

 AÈ¨£õß

 {Ó¨ö£ß]À, (]Á¨¦, £aø\, }»®)

uøµ¯»[P›¨¦UöPÚz öu›Äö\´¯¨£mh Chzøu |ßS 

AÁuõÛzx Auß GÀø»PøÍU Phuõ]°À Áøµ¢x öPõÒP.

E[PÍx B]›¯º, HøÚ¯ ©õnÁºPÒ BQ÷¯õ¸hß ¤ßÁ¸® 

Âh¯[PÒ £ØÔU P»¢xøµ¯õhÄ®.

 y  uøµ¯»[P›¨ø£a ö\´¯ÄÒÍ ChzvÀ Áß, ö©ß TÖPÎÀ 

A÷u Chzv÷»÷¯  Âh¨£hÄÒÍ TÖPøÍz vmh Áøµ 

£hzvÀ ]Á¨¦¨ ö£ß]»õÀ SÔzxUöPõÒP.

 y •Êø©¯õP APØÓ¨£h ÷Ási¯ TÖPøÍ £aø\ {ÓzvÚõÀ 

SÔzx öPõÒP.

 y Ch®©õØÔ |h¨£h ÷Ási¯ TÖPÒ Põn¨£k©õ°ß «Í 

{ÖÁ¨£h ÷Ási¯ Chzøu }»{ÓzvÚõÀ SÔzxU öPõÒP.

SÔ¨¦ & E[PÍõÀ SÔUP¨£mh TÖPÎß ö£¯ºPøÍz vmh¨  

    £hzvÀ SÔzxU öPõÒÍ ©ÓUP÷Áshõ®.
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ö\¯Ø£õk 1'11

öu›Äö\´u ö©ß ©ØÖ® Áß TÖPøÍz vmhªmh uøµ¯»[P›¨¦a 

ö\´²® Ch[PÎÀ {ÖÄ÷Áõ®

÷uøÁ¯õÚ E£Pµn[PÒ

£õh\õø»a `Ç¼À ö£ÓUTi¯ ö©ß, Áß TÖPÒ

Ãmka`Ç¼À ö£ÓzuUP ö©ß, Áß TÖPÒ

öPõÒÁÚÄ ö\´¯¨£mh ö©ß, Áß TÖPÒ (•i²©õÚõÀ 

©mk®)

÷uøÁ¯õÚ ö£õ¸mPÒ

©söÁmi       ö\UPØÔ¯º   øP •Ò

S¨ø£Áõ›       §ÁõÎ   A»Áõ[S  

Pzu›US® Pzu›U÷PõÀ     AÍÄ |õhõ  øP AP¨ø£   

(÷uøÁUS Aø©¯ E£Pµn[PÎß ÁøPPÒ ÷ÁÖ£h»õ®)

 y E[PÍõÀ u¯õ›UP¨£mh vmhzxUPø©¯ uøµ¯»[P›¨¤À 

Dk£kP.

 y •u¼À APØÓ¨£h ÷Ási¯ TÖPøÍ APØÔU öPõÒP

 y APØÓõx Âh¨£h ÷Ási¯ TÖPÎÀ uøµ¯»[PõµzvØSz 

uõUPzøu HØ£kzx® TÖPÒ Põn¨£iß AÁØøÓ  APØÔU 

öPõÒP.

    E+® :-  •Ô¢u, CÓ¢u QøÍPÒ ÷£õßÓÚ

 y ©õØÔ |h¨£h ÷Ási¯ TÖPøÍ E›¯ Ch[PÎÀ {ÖÄP.

 y ¦vuõP EÒÍhUP¨£h ÷Ási¯ÁØøÓ E›¯ Ch[PÎÀ 

£¯ß£kzuÀ
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\õiPÎÀ ÁÍºUP¨£mh uõÁµ[PÒ 

‰»©õÚ uøµ¯»[P›¨¦

EnÄ¨ £°ºPøÍ¨ £¯ß£kzv  

uøµ¯»[P›¨¦

uøµ¯»[P›¨¦ ÷©ØöPõÒÍ¨£mh ¤µ÷u\zøu¨ £µõ©›zuÀ

uøµ¯»[P›¨ø£ ÷£qÁuØPõP AuøÚa ]Ó¢u •øÓ°À £µõ 

©›¨£x ªP •UQ¯©õÚuõS®. C[S {øÓ÷ÁØÓ¨£h ÷Ási¯ 

•UQ¯©õÚ P¸©[PÒ R÷Ç uµ¨£mkÒÍÚ.

 y }›hÀ

 y £\øÍ°hÀ 

 y E»º¢u Cø»PøÍ APØÖuÀ

 y uõÁµ[PÎß RÌ ÃÌ¢xÒÍ Cø»PøÍ APØÖuÀ

 y S¸ÂPÒ SÎUS® umkPÎß }øµ vÚ\› ©õØÖuÀ

 y ÷uøÁ¯õ°ß uõÁµ[PøÍU Pzu›zuÀ

 y JÆöÁõ¸ Bsk® CÓ¢u uõÁµ[PÐUS¨ £v»õP ¦v¯ 

uõÁµ[PøÍ |õmkuÀ   

E[PÍõÀ E¸ÁõUP¨£mh uøµ¯»[P›¨ø£ ÷©÷» SÔ¨¤h¨£m 

hÁõÖ £µõ©›¨£uß ‰»® £õh\õø»a _ØÓõhø» ªPÄ® PÁºa]

Pµ©õP¨ ÷£n •i²®.       
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1.3 Ãmkz÷uõmhzvÀ Â»[SPøÍ ÁÍº¨÷£õ®  

C¢u E£ Azv¯õ¯zøuU PØ£uß ‰»®

 • Ãmka`Ç¼À ÁÍºUPU Ti¯ Â»[SPøÍ 

öuõSvPÍõUPÄ®

 • Â»[SPøÍ ÁÍºUS®÷£õx ÁÇ[P¨£h ÷Ási¯ 

÷uøÁPøÍU SÔ¨¤hÄ®  

 • £À÷ÁÖ ÁÍºa]¨ £¸Á Â»[SPÐUS ÁÇ[P¨£h ÷Ási¯ 

EnÄPøÍ wº©õÛUPÄ®

 • ¤µ÷u\zvÀ ö£ØÖUöPõÒÍU Ti¯ ‰»¨ö£õ¸mPøÍ¨ 

£¯ß£kzv EnÄ¨ £[Rmøhz u¯õ›UPÄ®

 C¯¾©õS®.

ÃmkÁÍÂØS Á¸® £À÷ÁÖ Â»[SPøÍ AÁuõÛ¨£uß ‰»©õ 

PÄ® AÁØÔß {»ÄøPUSz ÷uøÁ¯õÚ `Çø» E¸ÁõUSÁuß 

‰»•® AvP ©QÌøÁ¨ ö£Ó»õ® GÚ uµ® 6CÀ PØÖÒ÷Íõ®. 

Ãmk ÁÍøÁa \õº¢x ÁÍºUP¨£k® Â»[SPÒ £ØÔ C¨÷£õx 

|õ® AÔ¢x öPõÒ÷Áõ®.
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ÃmkÁÍÂÀ PõnzuUP £À÷ÁÖ Â»[SPÒ

`Ç¼¾ÒÍ Â»[S ÁøPPÎÀ ÃmiÀ ]» ÁøP Â»[SP÷Í 

ÁÍºUP¨£kQßÓÚ. ÁÍºUS® ÷|õUPzvß Ai¨£øh°À AÁØøÓ 

¤ßÁ¸©õÖ ÁøP¨£kzu»õ®.

ÁÍºUP¨£k® ÷|õUPzvØPø©¯ Â»[Sz öuõSvPÒ

E+®:-  |õ´, Bk, A»[Põµ¨ £ÓøÁPÒ, 

A»[Põµ «ßPÒ, •¯À

A»[Põµ® ©ØÖ® 

ö\À»¨¤µõo

Â»[S EØ£zvPøÍ¨  

ö£ÖuÀ
E+®:- £õØ£_, Bk, ÷PõÈ, uõµõ

E+®:- |õ´, §øÚ, •¯À, A»[Põµ¨ 

£ÓøÁPÒ, A»[Põµ «ßPÒ

 CÍ® Â»[SPøÍ¨

ö£ÖuÀ

ÂÁ\õ¯ |hÁiUøPPÒ E+®:- G¸x  

£õxPõ¨¦ E+®:-  |õ´
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ö\¯Ø£õk 1'12 

E[PÍx ÁS¨¤¾ÒÍ |s£ºPÒ 10 ÷£øµU öPõsh SÊ 

öÁõßøÓ Aø©zxU öPõÒP. ¤ßÁ¸® AmhÁønø¯ E[PÍx 

A¨¤¯õ\¨ ¦zuPzvÀ ¤µvö\´x SÊ A[PzuÁºPÎÚx  

ÃkPÎ¾® Ãmkz÷uõmhzv¾®  ÁÍºUP¨£k® Â»[SPÒ 

£ØÔ¯ uPÁÀPøÍa ÷\P›UP. ÁS¨¤¾ÒÍ HøÚ¯ SÊÂÚµx 

uPÁÀPÐhß E[PÍx SÊÂß uPÁÀPøÍ J¨¤k[PÒ.

 SÊ A[Pzu

ÁºPÎß ö£¯º

 ÁÍºUP¨£

 k® Â»[

SPÒ

 A¢u Â»[SPÒ

Ah[S® öuõSv

  A¢u Â»[SPÍõÀ

QøhUS® £¯ßPÒ

 P©À £_

¦Óõ

•ø»³miPÒ 

£ÓøÁPÒ

£õÀ ö£ÓÀ 

ö£õÊx÷£õUS

ÃmiÀ ÁÍºUP¨£k® Â»[SPÎß ÁøP, GsoUøP Gß£Ú 

Ãmk ÁÍÂ¾ÒÍ ChÁ\v, AÁØÔß £µõ©›¨¦, Ãmka ö\õ¢ 

uUPõµ¸US QøhUS® K´Ä BQ¯ Âh¯[PÎß Ai¨£øh°À 

wº©õÛUP¨£k®. Ãmk ÁÍÂÀ Â»[SPøÍ ÁÍº¨£uÚõÀ G©US 

A÷ÚP £¯ßPÒ QøhUS®.

Ãmk ÁÍÂÀ Â»[SPÒ ÁÍºUP¨£kÁuß ÷|õUP[PÒ

 • Sk®£zvß ÷£õ\øn ©mh® ÷©®£hÀ

£õØ£_, •møh°k® ÷PõÈPÒ BQ¯ÁØøÓ ÁÍº¨£uß ‰»® 

÷£õ\øn ªUP EnÄPøÍ¨ ö£ØÖUöPõÒÍ •i²®.

 • Sk®£zvØS ÷©»vP Á¸©õÚzøu¨ ö£Ó •iuÀ

÷©»vP £õÀ, •møh, A»[Põµ¨ £ÓøÁPÒ, A»[Põµ «ß 

Sg_PÒ ÷£õßÓÁØøÓ ÂØ£øÚ ö\´Áuß ‰»® ÷©»vP 

Á¸©õÚ® QøhUS®.

 • ©õmka\õo, Bmöh¸ BQ¯ÁØÔ¼¸¢x E°ºÁõ² EØ£zv 

ö\´uÀ

©õmöh¸, Bmöh¸, ÷PõÈö¯¸ BQ¯Ú Qøh¨£uÚõÀ Ãmkz 

÷uõmh® ÁÍ®ö£Ö®

 • \ø©¯»øÓ°¼¸¢x PÈzöuõxUP¨£k® ÷uøÁ¯ØÓ ©µUPÔ 

ÁøPPÒ, ÷u[Põ´¨§, «v EnÄPÒ ÷£õßÓÁØøÓ Â»[S 
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PÐUS EnÁõP ÁÇ[SÁuß ‰»® ̀ ÇÀ ©õ_£kÁøuz uÂºUP 

•iuÀ

 • ÷uÜUPÒ ÷£õßÓÚ ©Pµ¢ua ÷\ºUøPø¯ ÷©ØöPõÒÁuÚõÀ 

£°ºPÎß ÂøÍa\À AvP›zuÀ.

 • `Ç¼À £ÀÁøPø© AvP›zuÀ.

 • uõµõ, •¯À, A»[Põµ «ßPÒ, S¸ÂPÒ BQ¯Ú Põµn©õP 

`ÇÀ AÇS ö£ÓÀ.

 • AiUPi Â»[SPøÍ AÁuõÛ¨£uÚõÀ EÍzv¸¨v HØ£hÀ.

 • Â»[SPÎß«x P¸øn PõmkÁuÚõÀ EÍ ©»ºa] HØ£hÀ.

 Ãmkz ÷uõmhzvÀ Â»[SPøÍ ÁÍºUS® ÷£õx PÁÛUP ÷Ási¯

Âh¯[PÒ

|õ® _P©õP ÁõÌÁuØS G©US Ãk, EnÄ, B÷µõUQ¯©õÚ `ÇÀ 

BQ¯Ú AÁ]¯©õS®. Â»[SPøÍ ÁÍºUS®÷£õx AÁØÖUS ]» 

Ai¨£øh Á\vPÒ ÁÇ[P¨£h ÷Ásk®. AøÁ Á¸©õÖ,

 • £õuP©õÚ `ÇÀ, HøÚ¯ Â»[SPÒ BQ¯ÁØÔ¼¸¢x £õx 

Põ¨ø£ ÁÇ[SÁuØPõÚ ©øÚ

 • ÷uøÁ HØ£kªhzx E»õÂz v›ÁuØPõÚ ChÁ\v

 • ö£õ¸zu©õÚ EnÄ 

 • ÷£õv¯ÍÄ }º

 • ©¸zxÁ ]Qaø\

Â»[SPÐUS EnÄ ÁÇ[SÁx £ØÔ Bµõ´÷Áõ®

Â»[S EnÄ

Â»[SPÎß ÁÍºa], AßÓõha ö\¯Ø£õkPÒ, ÷|õ´PÎ¼¸¢x £õx 

Põ¨ø£¨ ö£ÖuÀ BQ¯ÁØÖUS ]Ó¨£õÚ ÷£õ\øn AÁ]¯©õS®.   

BP÷Á, Â»[SPÐUS EnÅmkuÀ ªP CßÔ¯ø©¯õuuõS®. 

Â»[SPÒ EmöPõÒÐ® EnÂÀ Põn¨£k® \ª£õhøh¯U 

Ti¯ ÷£õ\ønU TÖPÒ EnÄUPõÀÁõ°À  APzxÔg\¨£k®. 

«v |õº¨£uõºzu[PÒ öÁÎ÷¯ØÓ¨£k®.

Â»[S EnÂÀ Ah[Q²ÒÍ \ª£õhøh¯UTi¯ ÷£õ\øn°ß 

AÍÄ, Pµmk|õ›ß AÍÄ BQ¯ÁØÖUS Aø©¯ Â»[SPÐUS 

ÁÇ[P¨£k® EnÄPÒ ¤µuõÚ©õP Cµsk ÁøP¨£k®.
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Â»[S EnÄ

Â»[SPÐUS ÁÇ[P¨£k® Ixzwß ÁøPPÒ

 • £À÷ÁÖ uõÁµ  ÁøPPÒ - 

E+®:- QÎ›^i¯õU QøÍ, C¨¤À C¨¤À QøÍ, £»õU QøÍ, 

•Ò•¸[øPU QøÍ. 

QÎ›^i¯õUQøÍ C¨¤À C¨¤À QøÍ •Ò•¸[øPU QøÍ £»õU QøÍ

 • ¦À ÁøPPÒ 

Â»[SnÁõP ÁÇ[P¨£k® ¦ÀÁøPPÒ Cµsk ÁøP¨£k®.

•	 ² öÁmi³mk® ¦ØPÒ (öÁmk¨ ¦À) 

     ² ÷©´¢xsq® ¦ØPÒ (÷©´a\Ø ¦À) 

öÁmk¨ ¦À  

Cx 1 & 1 1/2 m E¯µ® Áøµ ÁÍµU Ti¯x. öÁmi GkzxÁµ¨£mk 

Bk, ©õk ÷£õßÓÁØÖUS Fmh¨£k®.
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QÛ¨ ¦À ÷|¨¤¯º ¦À ¤µ÷P›¯õ ¦À

÷©´a\Ø ¦À

CøÁ öÁmk¨¦À ÷£õÀ E¯µ©õP ÁÍµõx. {»zvÀ £hº¢x 

ÁÍ¸®. C¢u¨ ¦ØPÒ öPõsh ÷©´a\À {»[PÎØS Â»[SPÒ 

AÝ¨£¨£mk ÷©¯ ÂkÁuß ‰»® AøÁ EnÄ ö£Ö®.

 
ø©uõÚ¨ ¦À (Buffalo grass) ¤µ÷P›¯õ ¦À

 

 • ÂÁ\õ¯¨ £UP ÂøÍö£õ¸mPÒ

E+®:- PÈzöuõxUP¨£k® ©µUPÔPÒ, £Ç[PÒ, £¯Ö, EÊ¢x 

BQ¯ £¸¨¦ ÁøPPÎß ÷PõxPÒ, øÁU÷PõÀ ©ØÖ® HøÚ¯ 

uõÛ¯¨ £°ºPÎß PÈÄPÒ

 • ÷ÁÖ uõÁµ¨ £õP[PÒ

    E+®:- ÁõøÇ°ß ÷£õ¼z usk, Røµ ÁøPPÒ, £»õa\UøP
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   £»õa\UøPÁõøÇ°ß ÷£õ¼zusk RøµÁøP & P[S[

Â»[SPÐUS ÁÇ[P¨£k® ö\ÔÄnÄPÒ

²   uõÛ¯ EnÄPÒ

A›]zuÂk, \õø©, AøµUP¨£mh ÷\õÍ Âzx, AøµUP¨£mh 

CÖ[S Âzx 

A›]zuÂk AøµUP¨£mh ÷\õÍÂzx 

CÖ[S©õ CÖ[SÂzx

²  ¤snõUS ÁøPPÒ

£À÷ÁÖ Âzx ÁøPPÎ¼¸¢x Gsön´ ¤›zöukUP¨£mh 

¤ßÚº Gg_® «v ¤snõUS GÚ¨£k®.

E+®:- ÷u[Põ´¨ ¤snõUS, GÒÐ¨ ¤snõUS, {»UPhø»¨     

          ¤snõUS
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GÒÐ¨ ¤snõUS÷u[Põ´¨ ¤snõUS

 • «ß  yÒ (- Cx PÈzöuõxUP¨£mh «Ûß £õP[PÒ E»ºzu¨£mk 

yÍõUP¨£mk u¯õ›UP¨£k® Â»[SnÁõS®.

 • P¸Áõmkz yÒ (- P¸Áõk PÍg]¯¨£kzu¨£k® Ch[PÎÀ 

QøhUS® ©Ûu £¯ß£õmkUS¨ ö£õ¸zu©ØÓ P¸Áõmøhz 

yÍõUQ Cx u¯õ›UP¨£k®.

 • Gß¦z yÒ (- CøÓa] EØ£zv°À Gg_® Gß¦PøÍ AÂzx 

yÍõUQz u¯õ›UP¨£k®.

 • ]¨¤z yÒ (- ]¨¤÷¯õkPøÍz yÍõUQz u¯õ›UP¨£k®.

«ß yÒ Gß¦zyÒ ]¨¤zyÒ
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ö\¯Ø£õk 1'13

E[PÍx Ãmi¼¸¢x AÀ»x Ãmkz ÷uõmhzv¼¸¢x 

ö£ØÖUöPõÒÍU Ti¯ Â»[S EnÄ ÁøPPøÍ ¤ßÁ¸® 

AmhÁønUPø©¯ £mi¯Ø£kzx[PÒ. CuØS Ãmi¾ÒÍ 

ÁÍº¢÷uõ›ß EuÂø¯ |õk[PÒ

Ixzwß ö\ÔÄz wß

EnÂ¼¸¢x Â»[SPÐUSU QøhUS® ÷£õ\øn

 • \Uvu¸® EnÄPÒ & CøÁ Põ÷£õøÁu÷µØÖ, C¼¨¤mk 

BQ¯Ú AvP® öPõsh EnÄPÒ BS®. CÁØÔß  ‰»® 

Â»[SPÎß \Uvz÷uøÁ §ºzvö\´¯¨£k®.

    E+®:-  Eøh¢u A›], ÷\õÍ®

 • ÁÍºa]  EnÄPÒ & CøÁ AvP ¦µuzøuU  öPõsh   EnÄ 

PÍõS®. CøÁ Â»[SPÎß EhÀ ÁÍºa]US AÁ]¯©õÚøÁ 

¯õS®.

          

 • £õxPõ¨¦  EnÄPÒ & ÂØÓªßPÒ, PÛ¨ ö£õ¸mPÒ BQ¯ 

ÁØøÓ AvP® öPõsh EnÄPÒ CvÀ Ah[S®.

     E+®:-  Gß¦zyÒ, ]¨¤zyÒ, RøµÁøPPÒ

Â»[SPÐUS EnÅmk®÷£õx PÁÛUP÷Ási¯Ú

Â»[S ÁøPU÷PØ£ AøÁ EmöPõÒÐ® EnÄPÒ £» ÁøP¨£k®. 

AÁØÖUSz ÷uøÁ¯õÚ EnÂß AÍÄ® ÷ÁÖ£k®. Â»[SPÒ 

ÁÍºUP¨£k® •øÓ, AÁØÔß ÁÍºa]¨ £¸Á® BQ¯ÁØÖUS 

Aø©¯ EnÄ ÁÇ[P¨£k® •øÓ ÷ÁÖ£k®. BP÷Á, Â»[S 

PÐUS EnÄ ÁÇ[S®÷£õx PÁÚzvØöPõÒÍ ÷Ási¯ Âh 

¯[PÒ £ØÔ AÔ¢xöPõÒ÷Áõ®.
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²  Â»[S ÁøP

©õk, Bk, ö\®©Ô¯õk BQ¯Ú uõÁµÄsoPÍõS®. AøÁ Pµmk 

|õºPÒ öPõsh Pµmk¨ £uõºzu[PøÍ²® \ª£õhøh¯a ö\´¯U 

Ti¯ BØÓø»U öPõskÒÍÚ. CuØöPÚ AÁØÔß \ª£õmkz 

öuõSv Â÷\h©õP Aø©¯¨ ö£ØÖÒÍx. BP÷Á, CÆÁõÓõÚ 

Â»[SPÐUS EnÁõP ¦À ÷£õßÓ IxzwÁÚ[PøÍ AvPÍÂÀ 

öPõkUP»õ®. ÷PõÈPÒ, uõµõ BQ¯Ú AøÚzx•soPÍõS®. 

CøÁ uõÁµ EnÄPøÍ²® Â»[SPÎ¼¸¢x ö£Ó¨£k® EnÄP 

øÍ²® Esq®. CøÁ Pµmkz wÁÚ[PøÍ \ª£õøh¯a ö\´²®. 

² Â»[SPÎß £À÷ÁÖ ÁÍºa]¨ £¸Á[PÒ

Á¯x ©mhzvØPø©¯ Â»[SPÒ £À÷ÁÖ ÁÍºa]¨ £¸Á[PÎÀ 

Põn¨£k®. CÍ® £¸Á®, ÁÍºa]¨  £¸Á®,  CÚ¨ö£¸UP¨ 

£¸Á® BQ¯Ú÷Á AøÁ¯õS®.

©õkPÎß ÁÍºa]¨ £¸Á[PÒ

©õmkU PßÖPÒ uõ´¨£_Â¼¸¢x £õÀ Si¨£uØS AÝ©vU 

P¨£k®. ÁÍ¸®÷£õx IxzwÁÚ®, ö\ÔÄzwÁÚ® BQ¯Ú 

ÁÇ[P¨£h ÷Ásk®. Cuß÷£õx IxzwÁÚzxUS ÷©»vP©õP 

¤snõUS ÷£õßÓ ÁÍºa] EnÄPÒ AÎUP¨£h ÷Ásk®. 

Pº¨£•ØÓ £_UPÒ , £õÀ u¸® {ø»°¾ÒÍ £_UPÒ BQ¯ÁØÖUS 

AvP ÷£õ\øn öPõsh EnÄPÒ ÁÇ[P¨£h ÷Ásk®.

÷PõÈ°ß ÁÍºa]¨ £¸Á[PÒ

Sg_¨ £¸Á® ÁÍ¸® £¸Á® •møh°k® £¸Á®

Á¯xz öuõSvU÷PØ£, ÷PõÈPÎß £¸Á[PÒ öuõhº£õP |õ® PÁ 

Ú® ö\¾zx÷Áõ®. £À÷ÁÖ £¸Á[PÐUSz ÷uøÁ¯õÚ ÷£õ\øn 

QøhUPU Ti¯uõPz u¯õ›UP¨£mh EnÄU P»øÁPÒ \¢øu°À 

öPõÒÁÚÄ ö\´¯UTi¯uõP EÒÍÚ.
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£¸Á® ÁÇ[P¨£k® EnÄU P»øÁ

Sg_¨ £¸Á®

ÁÍºa]¨ £¸Á®

•møh°k® £¸Á®

Sg_UPõÚ wßP»øÁ (]U©õè)

ÁÍº£¸ÁU ÷PõÈUPõÚ wßP»øÁ (S÷µõ 

Áºì ©õè)

•møh U ÷P õÈ UPõÚ  wßP»øÁ                      

(÷»¯ºì ©õè)

]U ©õè S÷µõÁºì ©õè ÷»¯ºì ©õè

Sg_¨£¸Á® ÁÍº£¸Á® •møh°k® £¸Á®

²   Â»[SPÒ ÁÍºUP¨£k® •øÓPÒ

£» •øÓPÎÀ ÷PõÈPøÍ ÁÍºUP»õ®. ÷PõÈPÎß ÁÍº¨¦ 

•øÓUPø©¯ EnÄ ÁÇ[P¨£k® •øÓ²® ÷ÁÖ£k®.

AvP ChÁ\v EÒÍ Ch[PÎÀ Â»[SPÒ _u¢vµ©õP |h©õi 

EnÄ ö£ØÖU öPõÒÍ AÝ©vUP¨£k®. CµÂÀ u[SÁuØS ©mk® 

©õmkzöuõÊÁ®, ÷PõÈ©øÚ ÷£õßÓ Á\vPÒ ÁÇ[P¨£k®.

Â»[SPøÍ ÁÍºUS®÷£õx ¤ßÁ¸® •øÓ°À EnÄ ÁÇ[P¨ 

£k®. ÷©´a\¾US¨ ¦ØÓøµUS AÝ¨¦uÀ ^E+®:-©õk)

Cøµ÷ui Esn vÓ¢x ÂkuÀ ^E+®:- ÷PõÈ&
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©õk ÷©´¢x EnøÁ¨ ö£ÓÀ ÷PõÈPÒ Cøµ ÷uhÀ
             

ChÁ\v ÷£õuõu \¢uº¨£[PÎÀ |õÎß AvP ÷|µ® ÷PõÈPÒ 

©øÚ°ÝÒ Aøhzx ÁÍºUP¨£k®. CÁØÖUS öÁÎ°¼¸¢x 

EnÄ öPõsk Á¢x ÁÇ[P¨£k®. 

 • ¦Àø» öÁmiU öPõsk Á¢x öuõÊÁzv¾ÒÍ EnÄz 

öuõmi°À ChÀ   E+®:-  ©õkPÒ

 • ©µUQøÍPøÍ öÁmiU öPõsk Á¢x ©øÚ°ÝÒ öuõ[PÂhÀ

E+®:- BkPÒ

 • ö\ÔÄ EnÄPøÍ EnÄ¨ £õzvµ[PÎÀ ChÀ

E+®:- ©õkPÒ, ÷PõÈPÒ

©õkPÐUS EnÄ ÁÇ[PÀ ÷PõÈPÐUS EnÄ ÁÇ[PÀ
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ö\¯Ø£õk  1.14
ÁÍº£¸ÁU  ÷PõÈPÐUPõÚ EnÄU P»øÁø¯z  u¯õº ö\´÷Áõ®

‰»¨ ö£õ¸mPÎß AÍÄPÒ (1Kg  CøÚz u¯õ›UP)

A›]z uÂk    350 g 
÷\õÍz yÒ     200 g
÷u[Põ´¨ ¤snõUS   150 g
Eøh¢u A›]     100 g     

£¯ØÓ® ©õ     100 g    

P¸Áõmkz yÒ    50  g     

]¨¤z yÒ     25  g   

E»ºzvz yÍõUP¨£mh

C¨¤À C¨¤À Cø»PÒ   25  g 
(CuØöPÚ E[PÒ ¤µ÷u\zvÀ Põn¨£k® ÷ÁÖ ‰»¨ 

ö£õ¸mPÐ® £¯ß£kzu¨£h»õ®)

EnÄU P»øÁø¯z u¯õ›zuÀ

C[S GÀ»õ¨ ÷£õ\ønPÐ® P»øÁ°À \©ÚõP¨ £µ¢v¸zuÀ  

•UQ¯©õÚuõS®. C[S SøÓ¢u AÍÂ¾ÒÍ ö£õ¸mPÎÀ 

P»zuø» Bµ®¤zx AvP AÍÂ¾ÒÍ ö£õ¸mPÒ Áøµ •øÓ÷¯ 

P»zuÀ ÷Ásk®. 

AuØPø©¯ •u¼À ]¨¤zyÒ, C¨¤À C¨¤À Cø»z yÒ 

BQ¯Ú P»UP¨£kÁ÷uõk öuõhº¢x Tiaö\À¾® •øÓ°À 

ªP |ßÓõPU P»USuÀ ÷Ásk®. CuøÚ ÁÍ¸® ÷PõÈUSg_

PÐUPõÚ EnÁõP ÁÇ[P»õ®.

CUP»øÁø¯ E»º¢u ChzvÀ PÍg]¯¨£kzv øÁzuÀ 

AÁ]¯©õS®.


